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Introductie
Dit document is aangelegd ten behoeve van het versimpelen en verduidelijken
van het werkproces om een niet-Revit native model op een succesvolle manier
te implementeren binnen het Innobrix platform.

Uitgangspunten
Er zijn bepaalde uitgangspunten om in acht te nemen voordat je aan de gang
gaat.

Het teken- of modelleer pakket van oorsprong
De huidige werkmethodiek van Innobrix vereist dat een model vanuit Autodesk
Revit® wordt geëxporteerd naar een zogeheten Innobrix-bestand (*.ibx). Dit
betekent dat modellen van externe afkomst (SketchUp, ArchiCAD, Autocad etc.)
slechts indirect worden ondersteund en bepaalde onvoorziene resultaten
kunnen meebrengen. Vaak uit zich dit in de vorm van visuele eigenaardigheden
en/of misplaatste elementen na een export richting Innobrix. Vaak zijn hier wel
oplossingen voor te vinden maar dit vereist enig handwerk en tijd om te kunnen
corrigeren. Houd hier dus rekening mee!

Locaties van Nulpunten
Alle elementen, families en overige objecten hebben binnen Revit een eigen
nulpunt. Dat geldt ook voor IFC-afkomstige elementen. (Deze kunnen zelfs
meerdere nulpunten hanteren afhankelijk van het gebruikte
coördinatensysteem).
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(Face) Normal Oriëntatie
Zo nu en dan kan het voorkomen dat je in Innobrix objecten ziet die
‘binnenstebuiten’ gekeerd lijken te zijn ondanks dat het materiaal geen
transparantie heeft. Dit heeft in vrijwel alle gevallen te maken met de oriëntatie
van de (polygonen van de) geometrie / mesh. Zie onderstaande afbeelding ter
indicatie.

Dit is vaak een onwenselijk effect en ontstaat vaak door slechte modelkwaliteit
of uit het feit dat dit een object betreft dat meerdere keren tussen teken- en
modelleer pakketten geëxporteerd en geïmporteerd is. Dat gaat regelmatig
gepaard met enige vorm van dataverlies, waaronder dus Normal-data.
Afhankelijk van je tekenpakket kun je dit zelfstandig oplossen. Revit zelf heeft
helaas geen tooling om dit te kunnen repareren (behalve beperkte toegang tot
een face via de API). Dit soort problemen zul je binnen Revit zelf ook niet snel
tegenkomen omdat Revit altijd beide zijden van een polygoon rendert. SketchUp
rendert ook beide zijden en is daarom visueel ook vaak minder een probleem. Je
kunt echter wel zien welke objecten geflipte normals hebben via Sketchups’
Monochromatic-view. Objecten of ‘faces’ die geflipte normals hebben zijn in deze
Monochromatic view te herkennen aan een ‘blauwgrijze’ tint. Zie ook
onderstaande afbeelding:
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Materialen
Bij het importeren van externe objecten kan het zijn dat sommige materialen
(ongewenst) gedeeld worden met bepaalde elementen. Zo kan het voorkomen
dat het materiaal van de vloer hetzelfde is als dat van de binnenwanden. Voor je
het weet zit er laminaat op je muren.
Om dit op te lossen is het beste uiteraard terug naar je tekenpakket te gaan en
nagaan of je tussen deze 2 (of meer) componenten verschillende materialen kan
toekennen. Daarna kun je het element weer importeren binnen Revit en dus
doorzetten naar Innobrix.
Alternatief is het (soms) mogelijk om een material override uit te voeren op
geïmporteerde objecten via Revit door dit via het Object Styles menu aan te
passen. (Manage→ Object Styles→ Imported Objects).
Eventuele texturen die je vanuit SketchUp mee wilt nemen naar Innobrix dien je
binnen Innobrix Studio zelf te uploaden en toe te kennen aan het juiste
materiaal.

SketchUp
Introductie

SketchUp is een tekenprogramma dat zich conceptueel bevindt op het snijvlak
tussen parametrisch modelleren (zoals Revit) en geometrisch modelleren (zoals
3DSMax, Blender). Het programma wordt ontwikkeld en onderhouden door
Trimble, maar afhankelijk van het afgenomen licentietype kan je weinig tot veel
bestandsformaten exporteren en importeren. Het is tevens mogelijk om binnen
dit programma (face) normal oriëntatie te kunnen aanpassen.
Een .OBJ exporteren is enkel mogelijk wanneer je voor SketchUp een Pro licentie
hebt afgenomen.

OBJ→ Revit→ Innobrix

Een (wavefront) *.OBJ bestandsformaat is een inmiddels vrij oud maar goed te
gebruiken 3D formaat. Het bevat slechts 3D geometrische informatie met een
bijbehorende materiaal mapping in de vorm van een .mtl bestand. Een .OBJ
wordt vaak gebruikt in visualisatiesoftware, wat het dus ook uitermate geschikt
maakt voor toepassing binnen Innobrix.
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Uitleggen hoe je een .OBJ exporteert vanuit SketchUp is buiten de scope van dit
document. Hiervoor refereren we naar onderstaande pagina.

https://help.sketchup.com/en/sketchup/exporting-obj-files

Het is nog wel belangrijk op te merken dat dit document een

Stap 1: OBJ importeren in een Revit family
Allereerst dient opgemerkt te worden dat het pas sinds Revit 2023 (!) mogelijk is
om een .OBJ bestand te importeren of te linken. Aangezien de Innobrix add-in
geen gelinkte bestanden ondersteunt om te exporteren zal het via een Insert
actie moeten gebeuren.

Omdat het rechtstreeks embedden van een *.OBJ in een Revit project bestand
het (insertie) nulpunt van het geïmporteerde bestand vastzet (dit speelt niet
lekker met de Innobrix add-in tijdens het exportproces) is het beter om een
*.OBJ in te laden via een Revit family.

- Ga naar File→ New→ Family en Open een Generic Models Family
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Je komt nu terecht in de ‘Ref. level’ floor plan, waar je 2 groene lijnen ziet die
elkaar snijden. Het exacte snijpunt van deze 2 lijnen (reference planes) is
belangrijk omdat dit snijpunt het exacte nulpunt van de Revit family definieert. Je
kunt dit altijd verifiëren door op een lijn te klikken en na te gaan of de Defines
Origin parameter aangevinkt is.

- Ga naar Insert→ Import CAD→ OBJ Files (*.obj)

Het is belangrijk om na te gaan hoe de nulpunt(en) van je OBJ file(s) zijn
geplaatst en dat dit in ieder geval consistent is. Op die manier kan je dus de
Positioning: Auto - Origin to Internal Origin aanhouden.

Voor Place At: Level: Ref. Level geldt hetzelfde. Hier hoef je niks aan te passen als
de groepen / obj bestanden vanuit SketchUp op de juiste hoogte zijn
geëxporteerd.

Zodra je het model probeert te openen kan het zijn dat Revit aangeeft dat het
bestand ‘unitless’ is. Dat wil zeggen dat er geen dimensiewaarde is meegekomen
in het OBJ bestand. Dat is niet erg, maar we moeten wel aangeven welke working
units in het bestand van herkomst (SketchUp dus) gebruikt zijn voor dit model.
De aanname is dat er in Millimeters in SketchUp is gewerkt dus willen we dit ook
selecteren in de dropdown.

Zodra je OBJ bestand is geïmporteerd is het praktisch om een aantal zaken te
bevestigen.
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1. Is de schaal correct? Kloppen de verhoudingen?
2. Staat mijn woning niet op de kop vanwege de Y-as of Z-as omhoog conversie?
3. Ligt het nulpunt van mijn Sketchup model netjes op hetzelfde punt als dat van

mijn Revit family origin? (Dus het snijpunt van de 2 groene referentie lijnen?)
4. Zijn de materialen goed meegekomen?

Stap 2: Importeren in een Revit project
Nu het *.OBJ bestand goed in een Revit family is gezet kunnen we het gaan
plaatsen in een nieuw Revit document. Voordat we dit doen is het verstandig om
eerst de family op te slaan onder een passende naam. Bij eventuele
aanpassingen of andere aanvullingen kunnen we op deze manier de juiste family
terugvinden en overschrijven.

Voordat we dit gaan doen is het verstandig om eerst een simpel ‘grid’ in te
tekenen. Op deze manier hebben we iets meer overzicht over de groepen /
families die we inladen in het project, die we dan ook makkelijker kunnen
overzetten naar Innobrix.

- Maak een nieuw Revit project aan→ File→ New→ Project→ Kies voor
‘Architectural Template’→ Klik op ‘OK’.

Een nieuw project zal nu in Revit worden aangemaakt. Standaard zitten we naar
‘Level 0’ te kijken. Ter referentie is het handig om direct de zogeheten ‘Revit
Internal Origin’ te tonen. Dit nulpunt is een mooi startpunt van ons grid.
In de Views waarin dit handig is te tonen kun je dit tevoorschijn laten komen.
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- Ga naar (Floor Plan) Properties→ Visibility / Graphics Overrides→ Site→
Internal Origin→ Checkbox aanzetten→ OK

Als het goed is moet je nu onderstaand icoon kunnen zien in je View.

Het kruispunt van deze 2 pijlen is het (absolute) nulpunt van het document. Dit
is, in tegenstelling tot bijvoorbeeld de project base point of survey point, nooit aan
te passen.

Vanaf dit punt kunnen we nu even simpel een paar Model Lines gaan tekenen om
een ‘cel’ te definiëren. Deze ‘cel’ gebruiken we als referentiepunt(en) waar we
onze eerder aangemaakte family (of families) kunnen gaan aanhangen.

- Ga naar Architecture→Model Line en teken vanaf het nulpunt een kader
van 25m bij 25m.

Het kader mag in principe natuurlijk altijd groter of kleiner zijn, maar belangrijk
is dat in principe de voetafdruk van je woning er in zou moeten passen.

In principe kun je nu met behulp van de Copy tool een aantal van deze kaders
vrij vlot opzetten afhankelijk van het aantal families / groups dat je wilt gaan
inladen binnen Innobrix.
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De snijpunten linksonder van elke groep is het nulpunt dat we willen gebruiken
wanneer we de families importeren binnen het project.

Je vraagt je misschien af waarom het niet mogelijk is om een OBJ direct te
importeren in het project. Immers, je kunt de OBJ ‘gewoon’ als een generic
model component laden via de insert CAD-tool.

De reden hiervoor heeft te maken met de nulpunten die Revit (en onze add-in)
hanteert tijdens het inladen van een model. Om een erg lang en technisch
verhaal kort te maken zorgt het rechtstreeks inlezen van een OBJ voor een
compleet ‘statisch’ nulpunt. Het exporteren naar Innobrix gaat dan mis zodra je
na import van de OBJ in Revit deze geometrie zou verplaatsen. Dit is via het
embedden van een Revit family niet het geval.

- Ga terug naar je Family en selecteer deze. Klik vervolgens bovenin de ribbon
op Load into Project→ [projectnaam]→ OK

Je wordt vervolgens teruggezet naar het project waar je je family kan plaatsen.

- Klik op een nulpunt van een ‘cel’ om de component netjes te kunnen plaatsen
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Je kunt je 3D View openen om te bevestigen of alles zoals is verwacht is
neergezet, zoals onderstaande screenshot.

Het enige wat nu resteert is deze family te plaatsen in een Model Group en te
voorzien van correcte Innobrix parameters. Wat deze parameters precies moeten
/ kunnen zijn is beter uitgelegd in onze Innobrix Academy en valt buiten de
scope van dit document.
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In principe is het nu een kwestie van alle groepen die nodig zijn embedden in
een family en op bovenstaande manier inladen in je Revit project. Uiteindelijk zal
je bestand zoiets worden zoals onderstaande screenshot.

Voor een snelle BIM Publisher (optieloos model) mag je kort aannemen dat je de
volgende Innobrix parameters kan gebruiken:

Voor de begane grond:
● Innobrix: Types | [Modelnaam]
● Innobrix: Floor | 0
● Innobrix: Column | 0
● Innobrix: Row | 0

Voor de eerste verdieping:
● Innobrix: Types | [Modelnaam]
● Innobrix: Floor | 1
● Innobrix: Column | 0
● Innobrix: Row | 0

Voor de tweede verdieping:
● Innobrix: Types | [Modelnaam]
● Innobrix: Floor | 2
● Innobrix: Column | 0
● Innobrix: Row | 0

Voor het dak:
● Innobrix: Types | [Modelnaam]
● Innobrix: Floor | 3
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● Innobrix: Column | 0
● Innobrix: Row | 0

Voor eventuele extra verdiepingen tel je de ‘Floor’ in principe gewoon verder
door.

Mocht je een Woningconfigurator bouwen, dan kun je de dezelfde Model Groep
opbouw en parameters hanteren die daarvoor geschikt zijn en heb je doorgaans
meer OBJ’s te importeren en te verwerken in Revit. Maar de werkwijze is in
essentie hetzelfde.
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